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1 ČÁST PRVNÍ – instalace systému 

Předpisy vztahující se na proces instalace: 

� Předpis EU č. 115; 

� Předpis EU č. 67; 

� Instalace systémů, které jsou používányv Polsku musí odpovídat Příloze 9  dodatečných 

požadavků pro vozidla vybavená systémem LPG dle vyhlášky Ministerstva  

infrastruktury z 31. prosince 2002 o technických požadavcích vztahujících se na vozidla 

jakož i na rozsah potřebného vybavení, Sbírka zákonů č. 32, položka 262; 

� jiné místní předpisy. 

1.1 Seznam standardů 

1.2 Popis systému LPG STAG 400 DPI  

1.2.1 Rozsah použití 

Systém STAG 400 DPI byl zkonstruován pro řízené vstřikování LPG do vozidel s motory 

s přímým vstřikovávním benzínu. 

1.2.2 STAG 400 DPI – princip činnosti 
 Systém je složen z tytpických součástí včetně nádrže spolu s jejím příslušenstvím, plynových 

strubek, vstřikovačů LPG  a reduktoru. Systém připravuje palivo pro dávkování do sacího potrubí 

odpařením v reduktoru a stabilizací tlaku v závislosti na nastavení reduktoru. 

Plynná fáze LPG je dodávána do plynových vstřikovačů nainstalovaných na motoru vozidla, které 

vstřikují palivo do sacíhopotrubí pomocí plynových trysek. 

Vstřikovače jsou otevírány elektrickým signálem generovaným řídící jedntkou LPG systemu. 
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1.2.3 Schema zapojení systému  STAG 400 DPI 

1.2.3.1 Schema zapojení řídící jednotky STAG 400.4 DPI 

(*) – jednotlivá zapojení jsou popsána v přílohách. 
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1.2.3.2 Schema zapojení por řídící jednotky STAG 400.6 DPI or STAG 400.8 DPI 

(*) – jednotlivá zapojení jsou popsána v přílohách. 

1.3 Zásady instalace jednotlivých součástí LPG systému ve vozidle 

Před zahájením montáže LPG systému musí být ověřeno, že vozidlo je vhodné pro přestavbu. 

U vozidla, kde je zobrazen defekt motoru, musí být chyba opravena do plně fnkčního stavu. Zvláštní 

pozornost věnujte kontrole systému zapalování. 

V některých případech u některých motorů je doporučeno vyměnit vybrané prvky zapalovacího systému 

nebo zákazníka upozornit na nutnost výměny těchto prvků. Nedodržení výše uvedených doporučení 

může mít za následek poruchy v činnosti motoru poháněném LPG z důvodů, které nelze připsat 

samotnému systému LPG nebo způsobu instalace. 
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1.3.1 Plnící ventily 

Plnící ventily jsou namontovány v zadním nárazníku nebo vedle plnícího hrdla benzínu. 

Obr. 1.3.1 Otvor v zadním nárazníku Obr. 1.3.2 Plnící přípojka s krytkou 

Obr. 1.3.3 Plnící ventil zevnitř Obr.  1.3.4 Plnící ventil zvenku 

Obr.  1.3.5 Plnící ventil namontovaný vedle plnícího hrdla 

 benzínu 
Obr. 1.3.6 Přichyení trubky plnění 
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1.3.2 LPG nádrže 

Jsou používány ocelové nádrže. Při výběru nádrže se ujistěte, že použitý materiál na držáky vyhovuje 

příslušným požadavkům na pevnost. To platí zejména pro vozidla, u kterých je LPG nádrž montována 

na plastovou podložku. 

1.3.2.1 Válcové nádrže 

Obr.  1.3.7 Rám pro válcovou LPG nádrž Obr.  1.3.8 Připojení LPG nádrže 

Válcové ndrže jsou montovány s použitím držáku 

který je přišroubován k vozidlu. 

Při montáži rámu i pásů je potřeba dodržovat  

pevnost spojů. Jejich pevnost je potvrzena  

příslušnými zkouškami  provedenými výrobcem 

 nádrže. 

Nádrž by měla být namotována kolmo k  

podélnéose vozidla. Ponechejte 10 cm 

odstup mezi nádrží a zadním sedadlem. 

V případě, že je nádrž nmntována v kufru, 

který je oddělen od zadních sedadel přepážkou 

a není tedy možnost kontaktu mezi nádrží a 

zadním sedadlem, není potřeba ponechávat 

mezeru 10 cm. 

Obr.  1.3.9 V případě válcové nádrže namontované rovnoběžně s podélnou osou vozidla 
  musí být namontován prvek držáku tak, aby byl zamezen pohyb nádrže vpřed. 
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1.3.2.2 Toroidní nádrže 

Obr. 1.3.10  Namontovaná toroidní nádrž Obr.  1.3.11 Multiventil 

Obr.  1.3.12 Montážní součástky 

Toroidní nádrž by, být připevněny ke kovovým částem 
vozidla pomocí součástek, které jsou v balení u nádrže. 
(Obr. 1.3.12). Otvory musí být vyvrtány do karoserie  
tak, aby umožniliy protažení p mělylynových trubek, 
odvětrání plynové schránky (uvnitř dýnka) a také 
montáž upevňovacích šroubů. Plastová popěra by měla 
být umístna pod nádrží. Jakmile je nádrž namontovaná,  

připojte plynové trubky a kabeláž. 
Všechny šrouby a matky by měly být ochráněny  
protikorozním nátěrem (Obr. 1.3.13). 

Obr. 1.3.13 Pohled na nainstalovanou nádrž ze 

spodku vozidla 

Pro připevnení nádrže k vozidlu použijte továrně vyrobený spojovací materiál, aby byla zajištěna  odpovídající 

pevnost. 
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1.3.3 Příslušenství nádrže 

1.3.3.1 Výběr příslušenství nádrže 

Příslušenství by mělo být vybráno na základě požadovaného seznamu dílů uvedného v certifikátu  

o schválení nádrže. 

1.3.3.2 Instalace příslušenství 

Příslušenství by mělo být namontováno v souladu s požadavky výrobce. Trubky by měly být chráněny 

plynotěsným krytem s vývodem vně vozidla (Obr.  1.3.15). 

Obr.  1.3.14 Namontovaný multiventil Obr.  1.3.15 Připojení plynových trubek 

Nádrž musí být vybavena vhodným ventilem zde nazývaným multiventilem (Obr.  1.3.14). 

Ujistěte se, že zvolený multiventilmže být použit v dané nádrži. Pod ventil umístěte plynotěsnou schránku. 

Bezpečnostní šroubymultiventilu by měly být namontovány diagonálně. Následně  prostrčte plynové trubky  

a kabely prostrčené v chráničkách a pomocí vhodných spojů je připojte k multiventilu. 

Elektrické dráty mustí být k multiventilu připojeny podle schématu. Následně namontujte plynotěsnou schránku 

a také chráničku kabelů. Jakákoliv netěsnost od multiventilu musí být vypuštěna mimo vozidlo. Pro tento účel 

průchodka kabelu je těsně připojena k průchodce umístěné v otvoru předtím vyříznutém v karoserii 

(Obr.  1.3.16). Takový výstup nesmí být vyříznut v podběhu kola nebo podobné části, kde mohou být potíže  

s nečistotami nebo sněhem a nesmí být  u výfuku (Obr.  1.3.17). Odvětrání trubek (chrániček) by mělo 

 být co možná nejkratší. 
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Obr.  1.3.16 Kabelová chránička připojená k 

průchodce vyvedné vně vozidla 

Obr.  1.3.17 Průchodka zespodu vozidla 

V případě montáže toroidní nádrže musí být namontován odpovídající multiventil (Obr.  1.3.18). Následně,  

 protáhněte plynové trubky a připojte je k zásuvkám na těle multiventilu. Utěsněte otvor v plechu 

(Obr.  1.3.20) a připojte k eletroventilu indikátor hladiny plynu (Obr.  1.3.19). 

Obr.  1.3.18 Multiventil Obr.  1.3.19 Připojení multiventilu 

Obr.  1.3.20 Otvor pro plynové trubky v karoserii  

AC S.A. All rights reserved. Copying, publishing, distribution and any usage of the full or partial data included in the herewith document, particularly pictures, drawings, illustrations, trade marks etc. is 
                                                                                      strictly prohibited under the law. 

Page 10 of 44 



1.3.4 Montáž plynových trubek 

Plynové trubky by měly být vedeny takovým způsobem, aby bylo zajištěno snadné připojení a také možnost 

jejich technické revize v budoucnu. Ujistěte se, že zde není riziko poškození vozidla a nedlejte ohyby kolem ostrých 

hran, které by mohly nebezpečné pro uživatele vozidla nebo jiné jednotlivce. Trubky nesmí být spojeny navzájem. 

 

1.3.4.1 Montáž měděných trubek 

Obr.  1.3.21 Montáž elektrických kabelů v chráničce Obr.  1.3.22 Montáž kovových příchytek 

Používejte výhradně příchytky a trubky s antikorozní ochranou zkonstruované pro LPG systémy. Odstup 

mezi páskovými kovovými příchytkami musí být max. 70 cm (Picture 1.3.22). Při vedení trubek zajistěte, 

aby poloměr ohýbání byl dostatečný a nedošlo ke zmenšení průměru. Při zapojování součástí plynvého systému 

použijte kompenzační smyčky. Nedělejte žádné dodatečné spoje, které nejsou nutné pro účelné připojení 

jednotlivých součástí. 

1.3.4.2 Připojení nekovových trubek tř. 1 

Obr.  1.3.23 CPřipojení trubek k elektroventylu 

 

Obr.  1.3.24 FPřichycení kovovými sponkami 

Umístěte trubky do chrániček. Výhradně použijte  koncovky schválené pro použití s trubkami. 

Odstup mezi jednotlivými připojenými součástmi nesmí překročit  40 cm (Obr.  1.3.24).  
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 Minimální odstup od teplých součástí je 30 cm. Vyhněte se překřížení s výfukovým systémem. V případě, že  

je obtížné dodržet výše uvedené požadavky, použijte měděné trubky. 

1.3.5 Reduktor, filtr plynné fáze, PS-02 sensor 

 Reduktorje namontován na držák připevněný přímo na karoserii vozidla. 

(Obr.  1.3.25). Reduktor namontujte  v bízkosti motoru aby bylo možné dodržet délku plynových trubek  

pro připojení reduktoru a vstřikovačůs, v místě, které není vystaveno vysokým telotám. 

Obr.  1.3.25 Osazení reduktoru  Obr.  1.3.26 Připojení reduktoru 

Obr.  1.3.27 Napojení reduktoru na chladící  systém Obr.  1.3.28 Filtr LPG plynné fáze 
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Obr. 1.3.29 Navržená schémata pro připojení 2 reduktorů LPG/CNG. 

Reduktor byměl být připojen ke chladícímu systému pomocí kovových odboček vložených do chladícího 

systému vozidla (Obr.  1.3.27). 

Filtr plynné fáze by měl být připojen na nepohyblivé části vozidla, mimo dosah zdrojů tepla 

(Obr.  1.3.28). 

Tlakové čidlo PS-02 by měl být připojen na plynovou trubku mezi filtr plynné fáze a  pylnové  

vstřikovače (Obr.  1.3.30). 
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Obr. 1.3.30 Takové čidlo PS-02 

1.3.6 Elektronická řídící jednotka 

Elektronická řídící jednotka by měla být amontována na držák připojený přímo ke karosérii vozidla. 

Je doporučeno nainstalovat řídící jednotku poblíž motoru, kde není vystavena vysokým teplotám 

a vlhkosti. Typické místo pro instalaci je v motorovém prostoru.  

Obr.  1.3.31 Pohled na umístění řídící jednotky 
Obr.  1.3.32 Pohled na držák řídící jednotky 
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1.3.7 Montáž vstřikovacích trysek a trysek absolutního tlaku sacího potrubí 

Obr.  1.3.33 Umístění trysek v sacím potrubí 
     (pohled zvenku) 

Obr.  1.3.34 Umístění trysek  (pohled zevnitř 
       sacího potrubí) 

V některých případech  (viz přílohy), je nutné vymontovat sací potrubí. Otvory by měly být vavrtány 

pokud možno co nejblíže u hlavy motoru. Trysky namontujte tak, aby jejich ústí směřovalo  k sacím ventlům 

a zajistěte je proti vytočení. Připojte hadice od vstřikovačů  tryskám a zajistěte je  kovovými stahovacími 

svorkami. 

Namontujte vstřikovače na držák a připojte je hadicím od trysek. Následně připojte přívodní hadici a také  

hadici na měření podtlaku. Připojte kabeláž ke vstřikovačům, při dodržení přesného pořadí  podle  schématu. 

POZNÁMKA! Velikosti trysk pro jednotlivé typymotorů jsou specifikované v přílohách. 

Tryska absolutního podtlaku v sacím potrubí by měla být namontována na sdílené části sacího potrubí 

(pod škrtící klapkou). 

Obr.  1.3.35 Tryska absolutního podtlaku  v sacím potrubí 
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1.3.8 Připojení čidla tlaku benzínové lišty 

Plynový systém kompatibilní s motory s přímým vstřikem musí  obsahovat snímač tlaku benzínové lišty. Detailní pokyny 

byly  uvedeny v následujících přílohách. 

Obr. 1.3.36 Čidlo tlaku palivové lišty 

1.3.9 Instalace přepínače 

Přepínač musí být umístěn tak, aby ho řidič měl na  

viditelném místě. Dále musí být umístění přepínače  

přístupné jeho obsluze a nesmí bránit v řízení 

vozidla. 

Obr. 1.3.37 Příklad umístění P/G přepínače 

Aby bylo možné snadno připojit přepínač ke kabeláži  řídící jednotky STAG 400 DPI byl použit pár 3-pinových  

 konektorů. Po instalaci přepínače propojte  přiložené propojovací dráty při dodržení správného pořadí  

viz Obr. 1.3.38. 
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Obr 1.3.38 Připojení a pořadí drátů Obr. 1.3.39  P/G přepínač. 

POZNÁMKA! Přepínač musí být připojen ke kabeláži v kabině řidiče. 

1.4 Schválení vozidla pro instalaci LPG systemu 

Ujistěte se, že motor vozidla je zahrnut do seznamu podporovaných typů motorů 

                  ( příloha Dodatky tohoto manuálu ). Nepokračujte v instalaci pkud motor není 

mezi podporovanými typy. 

Proveďte technickou prohlídku motoru vozidla. V případě že je motor opotřebovaný nebo vykazuje 

vady, opravte motor před instalací do plně provozního stavu. 

 

1.5 První spuštění systému vstřikování plynu 

Natankujte vozidlo a zkontrolujte těsnost jednotlivých částí systému. 

Zkontrolujte spojení řídící jednotky s LPG systémem. 

Proveďte autokalibraci a nastavte během jízdy přizpůsobení (korekce). 

1.6 Kontrola kvality montáže 

Ověřte kompletnost systému 

Ověřte těsnost systému 

Kontrola výkonu LPG systému 
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2 Část druhá – AC STAG diagnostický software 

2.1 Popis diagnostického software 

2.1.1 Připojení řídící jednotky k PC 

Po ukončení montáže připojte k řídící jednotce STAG 400 DPI počítač se softwarem AC STAG. 
K tomu použijte  rozhraní AC S.A. RS 232 nebo  USB interface. Před spuštěním programu, otočte 
klíčkem v zapalování tak, aby bylo spuštěno napájení a aktivovala se řídící jednotka a byla schopná  
komunikace. Jakmile byl spuštěn program, program AC STAG provede automaticky pokus o spojení přes 
COM port, ke kterému rozhraní byl připojen. Stavové okno v levém dolním rohu aplikace upozorní  
uživatele o správnosti připojení. 

Obr. 2.1.1 Detekční okno řídící jednotky 

Obr. 2.1.2 “Tabulka parametrů”  (Parametry vozidla) 
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Obr. 2.1.2a “Tabulka parametrů”  (nastavení plynové řídící jednotky) 

V případě zvolení jiného portu z menu Port v horní části obrazovky zobrazí se zpráva 
“NO LPG controller!”. 

Obr. 2.1.3  okno “System varování” seznam “Portů” v liště Menu  

2.1.2 Verze diagnostického systému 

Jakmile se spustí diagnostický software AC STAG  bude verze zobrazena v horní lišttě na obrazovce.  
Obr. 2.1.4 Indikovaná verze 0.9.229. 

Obr 2.1.4 Lišta hlavního menu 
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2.1.3 Hlavní menu 
  Hlavní menu obsahuje následující možnosti: 
                   Port – umožňuje změnit komunikační port, navázat a ukončit spojení s řídící jednotkou 
                   a stejně tak aktivovat mod automatické detekce připojení; 
          
 
                    Okno – výběr možností aplikace v hlavním okně . 

 

Obr. 2.1.5 Okno „výběr možností „ v hlavní  liště 

“Okno” menu umožňuje obnovit hlavní okna v případě že byla uzavřena. AC STAG  
umožňuje uřivateli volně uspořídat okna aplikace. Pro snadnou úpravu jednotlivých oken 
použijte techniku kliknout a táhnout. Stisknutí a držení levého tlačítka myši na liště vybraného  
okna umožní jeho přesun. Uvolnění  levého tlačítka myši způsobí umístění nebo výběr okna  
v závislosti na aktuální poloze kurzoru. 

Jazyky  – volba jazyka; Pro nový výběr jazyka vyžaduje AC STAG jeden restart  
NÁSTROJE (TOOLS) – aktualizace řídící jednotky a led PŘEPÍNAČE, automatické rozdělení 
 Nastavení oken, obnova výchozího nastavení. 
 Aktualizaceřídící jednotky a LED přepínače je popsána v položce 2.1.13. 
Pro uložení nastavení a map řídící jednotky použijte ikonu diskety umístěné vpravo v okně  
Parametry. 

Nebo zvolte v hlavním menu Tools → Save parameters.. 

Obr. 2.1.6 Tabulka “Tools”  v liště menu 
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Na pevném disku počítače zvolte umístění, kam má být nastavení uloženo a klikněte na 
Save (ulož). Výše uvedeným postupem může uživatel uložit nastavení a mapy. 
Pro otevření nastavení a map klikněte na tlačítko “Open” umístěné na pravé straně 
Okna  Parametery, 

Nebo zvolte v hlavním menu Tools → Open saved parameters 
Aplikace bude po uživateli vyžadovat, aby označil soubor s nastavením (set extension). 
Označte soubor a otevřete ho. Následně se zobrazí okno Open saved parameters. 
Uživatel může otevřít jen nastavení, nebo jen mapy nebo obojí nastavení i mapy současně.  
Ve zobrazeném okně zaškrtněte požadovanou volbu a klikněte na Ok. 

Obr 2.1.7 Okno “Open saved parameters” (otevření uložených parametrů) 
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Help (pomoc) – informace o software a řídící jednotce 

Obr. 2.1.8  Okno “Gas controller info” (informace o 
řídící jednotce) 

Okno Gas controller info obsahuje následující parametry: 
      o Petrol (benzín) – zobrazuje celkový pracovní čas na benzín v následujícím formátu: 
          H – hodiny, M – minuty, % – celkový procentický podíl z pracovního času 
      o Since last connection (doba od posledního přpojení)– čas činnosti na benzín od 
         posledního připojení k PC 
      o Gas ( plyn) – celkový čas, kdy řídící jednotka pracovala na plyn 
      o Since last connections (doba od posledního připojení)– čas činnosti na plyn od posledního  
           připojení k PC 

   
      o Service(servis) –nastavení času do pravidelné revize. Jakmile pracovní čas na plyn 
          v řídící jednotce dosahne hodnoty času nastaveného pro revizi, řídící jednotka, 
         jakmile je vypnuto zapalování, informuje uživatele systému o potřebě revize zvukovým 
         signálem. Způsob nastavení času pro revizi systému je popsaný v následující části.  
         Záporná hodnota ukazuje čas, který uběhl od prvního zadání kdy je potřeba provést revizi. 
         Pro nastavení času revize klikněte na  

Tlačítko v okně Gas controller info; a zobrazí se následující okno: 
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Obr. 2.1.9 Okno “Service set” (nastavení 
servisu) 

Požadovaný čas do revize je počítán na základě projezdu km, po kterých  
má být revize provedena. V základním nastavení pro výpočet času revize je  
použita hodnota 1h – 50 km; přesto hodnota koeficientu může být měněna. Ve výše  
uvedeném okně je zvolena revize po 10.000 km (1 km = 0,62 mile) což v tomto 
konkrétním případě představuje 200 hodin provozu. 
Volba “Inactive” ve zvoleném okně, umožňuje vymazat revizi. Jakmile byla  
zvolena tato možnost, řídící jednotka nebude kontrolovat čas zbývající do revize.  

Nastavení dolní hodnoty operačního času v okně Gas controller 
Info zahrnujes následující možnosti nahrané řídící jednotkou: 
  o First PC connection (první připojení PC) – datum, kdy byla řídící jednotka poprvé 
       připojena k PC s diagnostickým software; 
  o First change of settings (první změna nastavení)– první úprava nastavení 
       řídící jednotky; 
  o Last PC connection (poslední připojení k PC) – kdy byla řídící jednotka 
       naposledy připojena k PC s diagnostickým software; 
  o Mod. date 1 ÷ Mod. date 5 –seznam změn pokud jde o nastavení řídící 
       jednotky. Od nejnovějších k nejstarším; 
  o Clear errors (zjevné chyby)– nahrané chyby od posledního vymazání     
       v plynové řídící jednotce  
  o Unknown change of settings (neznámá změna nastavení)– tato informace 
se zobrazí, pokud nastavení řídící jednotky je modifikováno s datem předcházejícím 
datu poslední modifikace. 
Kód, který byl použit pro modifikaci nastavení, je přiřazen každé události, kterou 
 PC identifikuje. Z data modifikace, jakož i z kódu, který identifikuje PC, který byl použit  
pro provedení změny, může uživatel určit, zda byly nebo nebyly provedeny změny 
v nastavení řídící jednotky třetími stranami. 

Následující dodatečné informyce můžete nalézt v dolní části okna: 
  o ECU S/N 
  o Your PC code (kód Vašeho PC) – přidělený kód PC, na kterém diagnostický 
program  AC STAG aktuálně běží. 
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2.1.4 Parametry řídící jednotky 

Dole na obrazovce je zobrazena verze firmware řídící jednotky, její typ a stejě tak datum a čas 
vytvoření firmware: 

STAG 400.8 DPI – typ řídící jednotky 
ver. 0.46 – číslo verze  firmware řídící jednotky 
12.0.0 – číslo verze řídící jednotky 
2012-06-22 09:34:14 – datum a čas vytvoření firmware řídící jednotky 

Skupina Parametrů byla rozdělena na podskupiny, které umožňují uživateli nastavit parametery 
Individuálně pro každé vozidlo. Kromě toho může uživatel libovolně uspořádat okna parameterů 
Přetažením levým tlačítkem myši a  jeho puštěním v požadovaném umístění. Uživatel může také okna 
slbalit: 
       Parametry motoru: 
          o Number of cylinders (počet válců)– počet válců vozidla 
          o Number of cyl. per coil (počet válců na cívku)– počet válců na jednu zapalovací cívku  
          o Engine code (kód motoru)– výrobní kód motoru 
        Kalibrační parametry: 
          o Operational pressure(pracovní tlak) – hodnota tlaku plynu, při které byla řídící jednotka kalibrovaná. 
              Je možné manuální nastavenípracovního tlaku, zatímco každá tato změna vyžaduje korekci  
              mapy multiplikátoru. 
          o Minimum pressure (minimální tlak) – hodnota tlaku plynu, pod kterou řídící jednotka přepína 
              na benzín. 
          o Gas temp.(teplota plynu) – teplota plynu, při které byla řídící jednotka kalibrována. Manuální 
              nastavení hodnoty teploty je možné, zatímco každá tato změna vyžaduje korekci mapy multiplikátoru.               
       Přepnutí do plynu: 
          o Fuel type (typ paliva)– typ paliva použitý pro účel přestavby (LPG or CNG) 
          o Switch-over threshold (práh přepnutí)– hodnota prahových otáček motoru, při kterých řídící 
              jednotka přepne na LPG 
          o Switch-over time (doba přepnutí) – doba od nastartování motoru, kdy může řídící jednotka 
              přepnout na LPG 
          o Reducer filling delay (zpoždění plnění reduktoru)– doba mezi  aktivací elektronického ventilu LPG/CNG  
              a aktivací plynových vstřikovačů 
          o Switch-over temp.(teplota přepnutí) – požadovaná teplota reduktoru, při které řídící jednotka 
              přepne na LPG 
          o Cylinder switch-over (přepínání válců)– čas který uplyne mezi aktivací přepnutí následného plynového 
       vstřikovače: 
          o Min gas RPM (minimální otáčky na plyn)– prahová hodnota otáček motoru, pod kterou řídící jednotka 
        přepíná na benzín 
          o Max gas RPM (max. otáčky na plyn)– prahová hodnota otáček motoru, nad kterou řídící jednotka 
              přepíná na benzín 
          o Pressure error delay (chyba zpoždění tlaku)– doba, po které řídící jednotka přepne na benzín, pokud je 
              tlak plynu nižší než minimální hodnota nastavená v kalibračních parametrech 
          o Min. gas temp. (minimální teplota plynu)– minimální teplota plynu, pod kterou řídící jednotka 
              přepne na benzín 
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Senzory a akční členy: 
  o Gas injector type (typ plynového vstřikovače)– nastavte nainstalovaný 
plynový vstřikovač. Jakmile 

kliknete na toto tlačítko, objeví se následující okno, obsahující nastavení plynových  
vstřikovačů: 

Obr. 2.1.10  Okno “Nastavení plynových vstřikovačů”  

Okno umožňuje uživateli nastavit korekce individuálně pro každou skupinu vstřikovačů 
a stejěn tak umožňuje přiřadit konkrétní vstřikovač příslušné lambda sondě vozidla. 

  o Lambda sensor 1 (Lambda sonda 1)– sonda 1 nastavení typu, Voltage(napětí) – standardní 
napětí sondy, UEGO –     rozsah sondy UEGO 
  o External sensor – dodatečně nastavený senzor. 
              Voltage sensor (lambda)  (napětí lambda)–  standardní napětí sondy. 
              UEGO sensor (lambda) – rozsah sondy UEGO. 
              Sensor emulation (snímač emulace)– nastavení použité v případě specializovaných spojů 
              kabeláže řídící jednotky (viz popis v přílohách tohoto dokumentu). 
Pokročilé nastavení: 
  o Extra inj. correction (extra korekce vstřikování)– další vstřikování bude označeno žlutým 
  podsvícením okénka „inj.dose“ v okně Monitor. 
      To je režim řídící jednotky, charakteristický dodatečným vstřikováním paliva. Nastavení posuvníkem  
      ovlivňuje reakci řídící jednotky STAG pro dodatečné vstřikování. Pokud je potřeba  dodatečné  
      vstřikování, nastavte hodnoty korekce pro dodatečné vstřikování metodou pokus omyl,  
      při dodržení STFT indikace korekcí. Doporučujeme nastavení, které bude ve výsledku korekcí  
      STFT kolem 0%.  STFT korekce čteme v okně  OBD Monitor nebo na diagnostickém scanneru SXC 1011. 

OBD: 
 o Configuration (konfigurace) – OBD komunikace zapíná/vypíná řídící jednotku STAG 400, detekuje 
     připojení diagnostického scanneru a nenarušuje přenos čímž umožňuje činnost s připojeným 
     scanerem. Komunikační funkce musí být vypnuta při použití diagnostického scaneru,  pokud  
     dojde k jeho připojení k řídící jednotce. 
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Na pravé straně okna“parameters“ je pět následujících tlačítek: 

Načte nastavení a soubor map 

Uloží nastavení soubor map 

Automatická úprava oken parametrů 

Návrat řídící jednotky do výchozího nastavení 

Návrat do předchozí velikosti okna Parametry 

Změna velikosti okna Parametry – pokud uživatel klikne na toto tlačítko, aby se usnadnilo 
uspořádání okna, nebude se zobrazovat osciloskop 

2.1.5 Mapy 

Toto okno obsahuje 3D mapy  v řídící jednotce. Jsou k dispozici tři pohledy na mapu. 

2D view 

Touto mapou lze měnit multiplikátor. Otáčky motoru jsou zobrazeny na svislé ose. 
Zobrazené hodnoty otáček mohou být měněny kliknutím levým tlačítkem myši na požadovanou hodnotu 
a potvrzením nové hodnoty. Dávky benzínu jsou zobrazeny na vodorovné ose. 
Vstřikovací čas může být měněn, když na něj klikneme levým tlačítkem myši a potvrdíme novou 
hodnotu. Kromě toho otáčky a hodnoty dávky zobrazené na osách mohou být upravovány následujícími  
kombinacemi kláves: “CTRL” + “ALT” and “SHIFT” + “←”, “→”, “↑”, “↓”. Hodnota násobiče zobrazená na mapě 
je procentická hodnota, která  je navíc barevně zobrazena v závislosti na bohatosti/ochuzení směsi. 
Sloupce a čáry mohou být přidány kliknutím pravým tlačítkem myši v prostoru mapy.  
Multiplikátor může být upraven zvýrazněním levým tlačítkem myši a stisknutím klávesy ENTER. Úpravu 
 lze provést také prostřednictvím následujících kombinací  kláves: “CTRL” and “↑” or “↓” as well as “+”,”-“.  
V případě stisknutí klávesy “Shift” a jejím podržení a při použití výše uvedených kombinací kláves bude  
multiplikátor změněn o přírůstek 10%. Výsledkem stiknutím tlačítka space-bar bude vysvícení bodu nejblíže 
provoznímu bodu motoru. Stisknutím a držením tlačítka space-bar během jízdy, lze snadno opravit hodnotu 
multiplikátoru  v nejbližším průsečíku dávky benzínu a hodnoty otáček. Pro úpravu lze také označit větší prostor.  
Navíc můžete zrušit sloupce i řádky. Pro vymazání řádky současně stiskněte “Shift” + “Delete” a pro  
vymazání sloupce současně stiskněte " Alt " + " Delete ". Před každým provedením mazání zvýrazněte požadované 
body. Extrémní hodnoty řádků a sloupců nelze odstranit. 
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Obr 2.1.11 2D mapy; klasický náhled 

Obr. 2.1.12 2D mapa; rozšířený náhled 

Mohou být zvoleny různé metody zobrazení 2D mapy a stejně tak řádků multiplikátoru. Pro výběr 
zvolené metody zobrazení , zvolte v hlavním menu Tools → Program se�ngs. Zobrazí se okno, 
které obsahuje dvě skupiny možností, vztahující se k možnostem metod zobrazení mapy. 

“Typ mapy” skupina určuje metodu uspořádání mapových bodů: 

“Klasická mapa” možnost uspořádat body rovnoměrně bez ohledu na hodnotu otáček; 
“Rozšířená mapa” možnost uspořádat body v poměru k dávce paliva a hodnotě otáček.  

“Přehled map” skupina určuje viditelnou oblast zobrazené mapy: 

“Plná mapa” umožňuje zobrazit celý dostupný rozsah dávky (až do 25 ms) a stejně tak hodnot 
otáček (až do  10.000/min): 
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3D zobrazení 

3D zobrazení je grafické znázornění 2D zobrazení. Je to ta samá mapa zobrazená trojrozměrně. 

Obr.2.1.13 3D zobrazení mapy 

Zobrazení řádku multiplikátoru 

Toto zobrazení umožňuje nastavení plynového systému; Musíme si však uvědomit, že nastavení  
multiplikátoru v daném místě vede ke změně v celém rozsahu otáček. Proto  doporučujeme, aby finální  
nastavení systému s 2D zobrazením mapy v daném případě bylo možné nastavit v dané oblasti pro  
konkrétní hodnotu otáček výlučně s klasickým vzhledem řádky multiplikátoru. Vodorovná osa 
představuje dávku benzínu a svislá osa představuje hodnotu násobiče. 
Nastavení multiplikátoru je založeno na zvýraznění místa levým tlačítkem myši a nastavením požadované  
pozice multiplikátoru pomocí kláves “↑” or “↓”. Stisknutím držením klávesy Shift změníte multiplikátor  
o přírůstek po 10 krocích. Navíc může být označená řádka multiplikátoru zvednuta na diagramu kliknutím myši a 
stiknutím “↑” nebo “↓”. V tomto případě platí u funkce klávesy Shift, že nastavení řádky je přírůstkové po 10 
krocích. 
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Obr.  2.1.14 Řádka násobiče; plné zobrazení 

Zobrazení teplotní korekce 

Obr.  2.1.15 Korekce teploty plynu 

Tabulka umožňuje nastavit korekce dávky v závislosti na teplotě plynu. Korekce použijeme tak, že v daném bodě 
zvýrazníme oblast pomocí levého tlačítka myši a nastavíme požadovanou hodnotu korekce stisknutím kláves 
 “↑” nebo “↓”. Pomocí pravého tlačítka myši zvýšíme počet bodů kliknutím v požadovaném místě. 
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2.1.6 Autokalibrace 

Po nastavení parametrů, které byly nastaveny v okně Parametry lze pokračovat v autokalibraci systému.  
Mechanické komponenty musí byt správně zapojeny, vstřikovací trysky musí mít správnou velikost  
a hodnota pracovního tlaku reduktoru musí být přiměřená. 
Proces autokalibrace je detailně popsán v kapitole 2.2. 

Obr. 2.1.16 Okno autokalibrace 

2.1.7 Chyby 

Pokud je navázána komunikace s OBD adaptérem karta „Errors“ (chyby) informuje uživatele o chybách 
 řídící jednotky STAG 400 DPI a stejně tak o chybách benzínové řídící jednotky,. V obou případech je možné  
chyby číst i mazat. 

Obr 2.1.17 Karta “Errors” (chyby) 
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Seznam chyb STAG 

                            Popis chyby 
Chyba parametrů, kontrola parametrů 
Chyba mapy, kontrola mapy 
Není připojena rozvodná deska 
Ztráta spojení s rozvodnou deskou 
Není teplotní čidlo na reduktoru 
Není plynové teplotní čidlo 
Zkrat obvodu teplotního čidla reduktoru 
Zkrat obvodu čidla teploty plynu 
Nízký tlak plynu 
Nejsou pulsy vstřiku – benzínový vstřikovač 1 
Nejsou pulsy vstřiku – benzínový vstřikovač 2 
Nejsou pulsy vstřiku – benzínový vstřikovač 3 
Nejsou pulsy vstřiku – benzínový vstřikovač  4 
Nejsou pulsy vstřiku – benzínový vstřikovač  5 
Nejsou pulsy vstřiku – benzínový vstřikovač  6 
Nejsou pulsy vstřiku – benzínový vstřikovač  7 
Nejsou pulsy vstřiku – benzínový vstřikovač  8 
Porucha plynového vstřikovače 1 
Porucha plynového vstřikovače  2 
Porucha plynového vstřikovače  3 
Porucha plynového vstřikovače  4 
Porucha plynového vstřikovače  5 
Porucha plynového vstřikovače  6 
Porucha plynového vstřikovače  7 
Porucha plynového vstřikovače  8 
Není plynový vstřikovač 1 
Není plynový vstřikovač  2 
Není plynový vstřikovač  3 
Není plynový vstřikovač  4 
Není plynový vstřikovač  5 
Není plynový vstřikovač  6 
Není plynový vstřikovač  7 
Není plynový vstřikovač  8 
Porucha periferního napájecího okruhu 
Porucha napájecího obvodu elektromagnetických ventilů 
Není elektromagnetický ventil 
Nízké napájecí napětí 
Vysoké napájecí napětí 
Chyba v obvodu komunikační sběrnice dat (přepnout na zem) 

Číslo chyby 
 32769 
 32770 
   256 
   257 
   512 
   513 
   514 
   515 
   772 
  1024 
  1025 
  1026 
  1027 
  1028 
  1029 
  1030 
  1031 
  1792 
  1793 
  1794 
  1795 
  1796 
  1797 
  1798 
  1799 
  1800 
  1801 
  1802 
  1803 
  1804 
  1805 
  1806 
  1807 
  2048 
  2050 
  2051 
  2052 
  2053 
  2305 
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2.1.8 Nahrávání 

Okno “Nahrávače” umožňuje uživateli procházet a vybírat soubory STAG parametrů prostřednictvím 
připojení diagnostiky k řídící jednotce STAG ve vozidle. Aby bylo možné procházet a vybírat soubory není 
potřeba připojit AC STAG software k LPG řídící jednotce.  
Jakmile je logger PC připojen použitím USB rozhraní, je automaticky rozpoznán a nahrané soubory 
jsou zobrazeny v okně. 
Okno loggeru zobrazí následující zprávu “Status: Recorder available”.  Verzi  firmvvare  loggeru 
a stejně tak bude zobrazeno aktuální datum. Od této chvíle může uživatel prohlížet soubory loggeru. 

 

Obr 2.1.18 Nahrané soubory 

Pro načtení souboru klikněte dvojitým kliknutím levého tlačítka myši na daný soubor nebo použijte 
Tlačítka „otevřít“. V případě , že označený soubor je nahraný (Obr. 2.1.18) zobrazí se u této  
Události na osciloskopu kurzor. 
To znamená, že uživatel stiskl tlačítko loggeru během chodu motoru vozidla. Okno monitoru zobrazí nahrané  
Parametry. 

Obr. 2.1.19 tabulka “Nahrávání”  

Kliknutím na tlačítko "Clear" vymažete soubory loggeru. Čas k provedení výše uvedené operace může být  
dlouhý neboť závisí na počtu nahraných souborů. 
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2.1.9 Okno  “Monitor”  

Okno Monitor zobrazuje aktuální parametry systému: 

LED přepínač kliknutím na přepínač přepínáte mezi LPG 
a benzínem 
Pressure [bar] (tlak) –Tlak LPG a tlak MAP v sacím potrubí 
Inj. dose [ms] (vstřikovaná dávka)– vypočtený čas vstřiku benzínu 
pro benzínové vstřikovače 
Gas Inj. dose [ms] (vstřikovaná dávka plynu)– čas vstřiku pro 
vstřikovače LPG 
Temperature [ºC] (teplota)– teplota vstřikovaného plynu, 
Teplota reduktoru a teplota uvnitř řídící jednotky 
Voltage [V] (napětí)– hodnota napětí pro lambda sondy a také 
baterie vozidla 
RPM [obr./min.] – hodnota otáček motoru 

Obr. 2.1.20 Okno monitoru 

Všechny parametry zobrazené v okně Monitor jsou také vidět na oscilloskopu. Konkrétní signál může 
být vypnut, aby nebyl do osciloskopu nahrán. Chcete-li tak učinit, odškrtněte políčko u názvu daného signálu.  
Kliknutím na název souboru se zobrazí v okně Monitor daný prametr a je možné změnit jeho barvu. 

Uživatel může nastavit počet zobrazených parametrů kliknutím na tlačítko 
na panelu parametrů, které parametry vyřadí . 

Tlačítko  

AC S.A. All rights reserved. Copying, publishing, distribution and any usage of the full or partial data included in the herewith document, particularly pictures, drawings, illustrations, trade marks etc. is 
                                                                                      strictly prohibited under the law. 

Page 33 of 44 



Navíc  označením rozsahu pásma lambda sondy (Lam. 1WR), u které je symbol a pokud je stisknut, změní se 
způsob zobrazení signálu sondy na sociloskopu  - signál je zesílen. 

Okno “Gas Inj. Dose” („dávka vstřikovaného plynu“) umožňuje uživateli přepnout konkrétní LPG vstřikovače 
kliknutím na příslušný symbol vstřikovače. Tato možnost umožňuje detekovat mechanické poškození vstřikovač. 

Obr. 2.1.21 Okno “Gas Inj. Dose”  

A navíc okno monitor nabízí možnost automatického  skrytí, která může být aktivována kliknutím na symbolbol 
                 v nástrojích okna. Skryté okno bude zobrazeno pouze  jako tlačítko. Skryté okno  automaticky  
spadne dolu pokud  tlačítkem myši ukážeme na toto tlačítko.  

2.1.10 Okno “Osciloskop”  

Aby bylo okno „Osciloskopu” vidět, zvolte v hlavním menu Window → Oscilloscope. 

Obr. 2.1.22 Okno “Osciloskopu”  

Okno “Osciloskop” zobrazuje všechny signály viditelné v oknech "Monitor" a  “OBD Monitor".  
Všechna ovládací tlačítka mají následující funkce počínaje z levé strany: 

Spuštění osciloskopu; 
Ukončení  osciloskopu; 
Nahrání aktuálního osciloskopu; 
Načtení osciloskopu z uloženého souboru na pevném disku; 
Snížení rozsahu diagramu; 
Zvýšení rozsahu diagramu. 

Uživatel může  ukázáním kurzoru na danou událost prohlížet soubory osciloskopu a hodnoty se zobrazí v okně  
MONITOR pod kurzorem. Uživatel může osciloskopem pohybovat ovládáním v dolní části obrazovky 
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nastavením kourzoru na okraj diagramu a podržením levého tlačítka myši. 

Obr.  2.1.23 Okno „File info” („informace o 
souboru“) 

2.1.11 Okno “OBD Monitor” 

Okno OBD Monitor zvolíte volbou z hlavního menu Window → OBD Monitor. 

Obr. 2.1.24 Okno “OBD Monitor” 

Okno OBD Monitor zobrazuje následující parametry: 
 Stav palivového systému CL – uzavřená smyčka (STFT and LTFT korekcejsou zapnuty), OT – nedostatečná  
 teplota motoru (topení), OF – otevřená smyčka vlivem chyby řídící jednotky, N/A – stav není k dispozici 
 STFT B1 – krátkodobé korekce paliva Bank I 
 STFT B1 – dlouhodobé korekce paliva Bank I 
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STFT B2 – krátkodobé korekce paliva Bank II 
LTFT B2 – dlouhodobé korekce paliva Bank II 

Kromě toho hodnoty STFT a LTFT jsou graficky znázorněny na výše uvedených ukazatelích. 
Okno OBD Monitor je nástroj, který usnadňuje nastavení vozidla za předpokladu, že je řídící jednotka STAG 
připojena k OBD vozidla. Správné připojení je indikováno blikajícím světlem v levém dolním rohu okna. 

2.1.12 Ukazatel množství plynu 

Aby bylo možné nastavit indikátor hladiny plynu klikněte pravým tlačítkem myši  na přepínač.  
Zobrazí se okno nastavení , které umožní zvolit hodnoty prahového napětí ukazatele. 

Obr. 2.1.25  Okno “Gas level indicator”  

Okno umožňuje provést následující nastavení: 

Gas level sensor type (typ čidla ukazatele množství) – Uživatel může zvolit z následujících snímačů 
hladiny  LPG: 
WPGH Hall sensor (3-drátový), 50 [kOhm], 90 [Ohm] rezistentní sensor (2-drátový) 
Charakteristiky – přírůstková metoda signálu snímače: snížení nebo  zvýšení 
Sound level (úroveň zvuku) – hlasitost bzučáku, 4 úrovně 
LED brightness level (úroveň svícení LED) – nastavení svítivosti LED ukazatele hladiny 
Buzzer position (umístění bzučáku) – jakmile je  namontovaný  LED400, musí uživatel zvolit umístění 
reproduktoru tak, aby byla dosažena správná viditelnost indikace hladiny LPG. 

Kolonky napětí musí být upraveny tak, aby byla zajištěna správná indikace hladiny. Jakmile je zvolen typ  
senzoru, nastavte maximální hodnotu pro prázdnou a plnou nádrž nastavením hodnot napětí včetně rozpětí, 
aby byla zajištěna správná indikace prázdné a plné nádrže. V obou středních políčkách zadejte odpovídající  
střední hodnoty. 
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2.1.13 Aktualizace řídící jednotky 

Otočte klíčkem zapalování tak, aby řídící jednotka byla napájena a umožnila aktualizaci firmware 
v řídící jednotce. V hlavním menu zvolte  Tools → Devices update. 

Obr. 2.1.26  Tabulka hlavního menu “Tools”  

Okno na obr. (Obr. 2.1.27) zobrazuje aktuální verzi firmware řídící jednotky a stejně tak budou zobrazeny  
dostupné aktualizace. Okno Parameters obsahuje seznam zařízení , pro která je aktualizace k dispozici. 
Aktualizace firmware pro STAG 400 DPI a LED přepínače je k dispozici. 
Aby bylo možné pokračovat v aktualizaci firmware, zvolte v okně Devices parameters  řídící jednotku  
(např. STAG 400 DPI) nebo LED přepínač (LED-400). Připojte logger a pro aktualizaci parametrů firmware  
STAG logger použijte tlačítko RECORDER. Z dostupných aktualizací v okně Available updates  vyberte  
požadovanou verzi. V případě že seznam aktualizací není zobrazen klikněte na tlačítko Read Update a vyberte 
požadovaný soubor z pevného disku počítače. Jakmile je vybrána požadovaná verze aktualizace firmware 
stiskněte tlačítko Update. Počkejte dokud aktualizační proces není kompletní. Průběh procesu aktualizace  
je znázorňován ve stavovém políčku. Motor musí být během aktualizace vypnutý. 

Obr.  2.1.27 Okno “Devices update” aktualizace zařízení 
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2.2 Programování řídící jednotky 

2.2.1 Autokalibrace 

Autokalibrace je možná, jakmile teplota reduktoru dosahne hodnoty 60 °C. Před zahájením autokalibrace 
nastartujte motor a počkejte , až lambda sonda začne pracovat. Vhodné LTFT a STFT korekce jsou důležité 
při provozu na benzín. Obvykle korekční hodnoty oscilují kolem 0%. Při provádění autokalibrace musí motor  
běžet na volnoběh. Motor nevytáčejte, klimatizace a světla by měly být vypnuté. Nepohybujte volantem,  
protože by to mohlo mít za následek nasprávný průběh kalibračního procesu.  Jakmile zvolíte okno  
auto-calibration a kliknete na tlačítko START, zobrazí se okno Choose engine code (zvolte kód motoru). 

Obr. 2.2.1 Choose engine code window 

Poznámka! Platný seznam kódů naleznete v seznamu příloh. 

Jakmile vyberete typ motoru zahájí se proces autokalibrace. 

POZNÁMKA! V případě že kód motru není zvolen správně nebude motor fungovat správně a vozidlo 
se stane nepojízdným!!! 

O postupu procesu kalibrace je uživatel informován ve stavovém řádku. Během kalibračního procesu může 
uživatel sledovat benzínové vstřikovací časy a přepínat na konkrétní  LPG vstřikovače. 
 Jakmile jsou nastaveny všechny vstřikovače,  je proces autokalibrace ukončen. 

Obr. 2.2.2 Okno Autokalibrace 
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2.2.2 Mapa multiplikátoru korekcí 

Obr. 2.2.3 Pohled na mapu multiplikátoru 

Jakmile je autokalibrace ukončena může uživatel pokračovat v nastavení vozidla za jízdy s vozidlem pomocí  
mapy multiplikátoru.  Zvolte kartu map a následně zvolte požadovanou možnost zobrazení. Doporučujeme  
následující metody úprav mapy: 

Nastavení v závislosti na vstřikovacích časech – při jízdě na benzín udržujte vstřikovací časy a  
zátěž  na viditelných bodech mapy multiplikátoru a na konstantní úrovni.. 
Pomoci Vám v tom může Calibration assistant (kalibrační asistent)  . Nástroj je reprezentován oknem, 
které zobrazuje zvětšenou řádku multiplikátoru pro usnadnění sledování vstřikovacího času. 

Obr. 2.2.4 okno “Calibration assistant”  (Asistent kalibrace) 

Asistent kalibrace  může být spuštěn z hlavního menu volbou v okně – 
Calibration assistant. Aby se asistent aktivoval klikněte za provozu na benzín na tlačítko Start.  
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Vstřikovací čas benzínu (červená čára) jakož i automatické přepnutí na LPG budou uloženy v okně 
asistenta kalibrace při stabilních podmínkách jízdy.. 

Obr.  2.2.5 Okno “Calibrační asistent”  

Následně po přepnutí – zelená čára indikuje aktuální čas vstřiku benzínu. 
Upravte multiplikátor takovým způsobem, abyste se ujistili, že po přepnutí zelená linka koresponduje s 
 červenou. Pro účely usnadnění práce zobrazuje okno asistenta otáčky a hodnotu tlaku uložené 
během jízdy na benzín (na číselníku označeno modrou barvou).  V případě překročení uložených hodnot  
otáček a tlaku změní se podsvícení ciferníků na žlutou. V případě, že zezelená ukazatel vstřikovacího času, 
umístěný na levé straně červeného ukazatele (směs je příliš bohatá), snižte multiplikátor v kalibrovaném 
bodě. Podobně v případě chudé směsi  zezelená ukazatel na pravé straně . V takovém případě zvyšte 
hodnotu multiplikátoru. Hodnota korekcí STFT a STFT (červená barva) je pro usnadnění zmrazena 
stisknutím tlačítka přepínače v okně asistent. To představuje hodnotu korekce, která se použije v  
kalibračním bodě těsně před přepnutím na LPG. Kromě toho se po přepnutí na LPG, na levé straně okna 
asistenta, zobrazí šipka, která informuje uživatele o doporučeném směru korekce multiplikátoru. 
Po přepnutí na LPG je v závislosti na tom, jaká mapa má být konfigurována (LM nebo 2D) je aktivována  
nejbližší  kalibrační oblast bodu. stisknutím tlačítek klávesníce “↑” nebo “↓” také provedete okamžité 
korekce. Za účelem ověření multiplikátoru přepněte na benzín a přesuňte se zpět do kalibračního bodu.  
Je-li to nutné, je možné přidat kalibrační body na řádku multiplikátoru kliknutím pravým tlačítkem myši. 
Zatímco motor běží na volnoběh, vypočítá se během autokalibrace druhý bod podél řádku multiplikátoru. Po 
nastavení všech bodů v jízdních podmínkách zkontrolujte také bod vypočtený při kalibraci. Jakmile 
Vozidlo zastaví ověřte jeho nastavení a pokud je to nutné proveďte úpravy. 
Pokud nastavujeme vozidlo v závislosti na vstřikovacích časech je dobrým zvykem pozorovat  
STFT a LTFT korekce s použitím OBD monitoru a okna kalibračního asistenta nebo diagnostikým scanerem  
SXC 1011 s cílem ověřit správnost nastavení. 
Stisknutím tlačítka  STOP přerušíme činnost asistenta. 
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 Úprava založená na pozorování  STFT korekcí – během jízdy, když jsou stabilní podmínky 
a kurzor je na zvoleném bodě mapy přepněte na LPG a pozorujte  pohyb STFT korekcí 
 (s použitím okna OBD Monitoru nebo diagnostického scaneru SXC 1011). 
 Nastavte bod multiplikátoru takovým způsobem, abste se ujistili, že korekce oscilují okolo 0%. 
V případě pozitivní hodnoty STFT zvyšte bod multiplikátoru, v opačném případě ho snižte. 
 Pokračujte dokud není dosaženo požadované korekce.  Jakmile byl požadovaný bod nastaven, 
zvyšte zatížení a přesuňte se k dalšímu bodu (bez přepínání) a opakujte výše uvedené kroky. 

Jakmile máme nastavenou mapu multiplikátoru ověřte výběr trysek při maximálním zatížení. Zkontrolujte  
STFT korekce při nahraných maximálních vstřikovacích časech benzínu, zda motor táhne při plném zatížení 
(plynový pedál je stlačený až k podlaze). Obvykle by hodnota korekcí měla oscilovat okolo nuly. 
 V případě, že změna multiplikátoru nemá žádný vliv a korekce STFT zůstávají kladné po  celou dobu 
nebo lambda sonda pracuje v rozsahu chudé směsi, znamená to, že velikost vstřikovacích  trysek LPG je příliš  
malá  a měly by být místo nich manontovány větší. Jakmile trysky vyměníte opakujte proces kalibrace.. 

Jamile je vozidlo nastaveno ověřte další nastavení vstřikování. V tabulce  Parameters – Advanced 
settings – Extra inj. correction  je posuvné ovládání, které se používá k nastavení LPG vstřikovačů 
v případě dodatečného vstřikování.. Dodatečné vstřikování je signalizováno v okně monitor žlutým podsvícením 
dávky vstřikovaného plynu. 

Obr.  2.2.6  Okno “Inj. dose” (dávka vstřiku) 

Tuto situaci obvykle doprovází dynamický nárůst výkonu motoru jako je akcelerace.V případě že je pozorováno 
dodatečné vstřikování sledujte STFT korekce a zda směs není příliš bohatá nebo chudá. Pro nastavení  
korekcí použijte posuvník a nastavte hodnotu korekcí tak, aby jste se ujistili, že STFT korekce jsou identické 
s korekcemi benzínovými  (obvykle okolo 0%). 

Obr.  2.2.7 okno “Advanced settings” (pokročilé nastavení) 

Posunem posuvníku doprava obohacujete dodatečné vstřiky LPG, zatímco posunem posuvníku 
Doleva ochuzujete dodatečné vstřiky LPG. 

V případě nastavení multiplikátoru přes řádku multiplikátoru (LM tlačítko v tabulce mapy) ) to nepostačuje 
pro nastavení v celém spektru otáček a použijte 2D mapu (2D tlačítko v tabulce mapy). 

AC S.A. All rights reserved. Copying, publishing, distribution and any usage of the full or partial data included in the herewith document, particularly pictures, drawings, illustrations, trade marks etc. is 
                                                                                      strictly prohibited under the law. 

Page 41 of 44 



Obr. 2.2.8 2D pohled na mapu 

Za účelem úpravy hodnoty multiplikátoru v kalibrační oblasti označte vybranou oblast a upravte  
hodnotu multiplikátoru vložením požadované hodnoty a stisknutím klávesy ENTER . 

Obr.  2.2.9 Změna hodnoty multiplikátoru na 2D mapě 

Pro změnu hodnot multiplikátoru můžete také použít klávesy  + a – nebo klávesy ↑ a ↓ při současném stisku  
a držení klávesy CTRL. Pro použití přírůskové změny o 10 % drže klávesu SHIFT. 

2.3 Činnost LED přepínače a zvukové signály (uživatelská příručkal) 

2.3.1 LED-400 přepínač 

Obr. 2.3.1 Pohled na přepínač LED-400  

Přepínač LED-400 je vybaven následujícími prvky: 

Kruh LED  – čtyři LED diody jsou uspořádány kruhově a ukazují aktuální stav LPG lv nádrži. 
Čtyři zelené LED indikují plnou nádrž. 
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Tlačítko s logem AC – umožňuje přepínat benzín/LPG a zobrazuje aktuální režim: 

nesvítí – vozidlo jede na benzín; 
pomalu bliká (jedenkrát za sekundu) – vozidlo jede na benzín a jakmile jsou dosaženy nastavené 
parametery, systém automaticky přepně na LPG; 
bliká normálně (dvakrát za sekundu) bez zvukového signálu – systém je přepnutý na LPG;  
to může trvat až 10 sekund v závislosti na parametrech motoru; 
bliká rychle (4x za sekundu) a vydává zvukové signály – chyba řídící jednotky (např. 
vypnutí vlivem prázdné nádrže); 
bílé podsvícení – vozidlo jede na LPG; 
červené podsvícení – vozidlo jede na LPG, ale nádrž je téměř prázdná. 

Když je přepínač LED-400 připojen k řídící jednotce STAG 400 jsou dostupné následující dodatečné funkce: 

 
           Nasatvení jasu LED (úroveň jasu – vyberte jednu ze 4 LED); 
           Ovládání hlasitosti bzučáku přepínače LED; 
           Úprava orientace LED přepínače aby bylo dosaženo správnéviditelnosti hladiny LPG 
            umístění bzučáku v referenčním bodě; 
           Automatická identifikace typu připojení  LED přepínače; připojení přepínače LED-400 
           je aplikací rozpoznáno jako LED-400. 

Obr.  2.3.2 Okno nastavení LED-400  

Řídící jednotka si pamatuje posledně nastavené palivo použité před vypnutím napájení  
klíčkem zapalování. 
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2.4 Zvukové signály 

Řídící jednotka vydává následující zvukové signály: 

Trojitý zvukový signál – přepnutí na benzín z důvodu nedostatečného množství  LPG v nádrži; 
Tři krátké zvukové signály a jeden dlouhý signál – chyba řídící jednotky po zapnutí zapalování; 
Dva krátké signály a jeden dlouhý signál – není provedena požadovaná revize. Jeďte do servisu a  
proveďte revizi. 

2.5 Technická specifikace 

Napájecí napětí 
Aktuální maximální odběr proudu řídící jenotkou (1 ohm LPG vstřikovače) 
Aktuální odběr proudu v režimu spánku 
Pracovní teplota 
Třída ochrany 

12[V] (-20% +30%) 

        25 [A] 
   < 10 [mA] 
-40 - 125 [°C] 
         IP54 

2.6 Přílohy 

Tato příručka obsahuje přílohy s pokyny vztahujícími se k montáži řídící jednotky STAG 400 DPI  
Do vozidel s různými typy motorů  
Přílohy jsou dostupné zde. 
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